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TDO3 - Manipulations des données sur GH

Dossier de ressources :
DATA
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Apergu général On veut utiliser le placement d’un point
comme maniére de choisir le degré
d’ouvertures de chaque brique

(00 e % ENSAM - S4 - MORPHO - TD4.3dm

(e0e % ENSAM - S4 - MORPHO - TD4.3dm

1. Réduire la taille des
faces de maniére a
percer les briques

2. Régler le facteur de réduction
de chaque face en fonction de la
distance par rapport a un point

% ENSAM - S4 - MORPHO - TD4.3dm

3. Créer des volumes de
découpe a partir de ces
faces réduites

% ENSAM - S4 - MORPHO - TD4.3dm

4. Découper les briques
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Démarrer un nouveau fichier GH

Commencez par ouvrir votre précédent fichier RHINO (.3dm),
pUiS le fichier Grasshopper (.gh) du TD2 (simulation).

Vous allez ensuite faire « Enregistrer sous... » : vous créez un
nouveau fichier avec un nouveau nom, etc. et tout le contenu
du précédent fichier.

@ Grasshopper- Edit View Display Solution Wind

e e New Document &N
I:| Maanétl Open Document... $0 Repérag(
Standard Recent Files % [sition des fenétrg
D v Q g E Save Document #S ) n
—
Save Backup

77777777 Export Quick Image... . —
Enregistrez ce nouveau fichier dans un

endroit bien rangé dans votre ordinateur,
et nommez le intelligemment :

NOMPRENOM - S4 — MORPHO - TD4

Export Hi-Res Image...
Document Properties...

Create User Object...
Insert Cluster Into File...

o == Save As...
ce gi i"
v
- Favors Enregistrer sous :  FC-S4-MORPHO-TDdgh )
20> @
E(Fv oo v iCloud Tags :
Ba8 ‘i W ‘/ Emplacements
=05 v v v < Ev)(Bv [ ENSAM - S4 - MORPHO ~ Q
& Tags
0' Nom ~ | Date de I'ajout Taille Type
>E oM 10 janvier 2023 4 18:15
> £ DATA

10 janvier 2023 a 18:15

D2 - Formfinding.pdf

Grasshopper Binary (*gh)

Annuler

Nouveau dossier

MORPHOLOGIE - Etude d’une coque simple

‘e

GH BINARY
Si le fichier du TD précédent
ne donne pas les résultats
escomptés, vous trouverez les
éléments nécessaires au TD
dans le dossier DATA

Solver

Explode Tree FC-Maillage coque

A part ce composant,
supprimez de ce nouveau
fichier tous les autres
composants du TD2.

FC-Maillage coque &

{l Preview
] Enabled
& Bake...

Wire Display
Disconnect

[2] Reverse
Flatten
[ Graft

[7) simplify

Set one Mesh
Set Multiple Meshes

Manage Mesh collection

Clear values
Internalise data

Extract parameter

(@ Help...

Le lien se coupe : le
contenu de ce composant
ne dépend désormais plus
de Rhino ni de précédents
composants

Panel

Panel

OMesh (V:121 F:96)
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Mise a I'échelle d'une liste d'éléments

En séparant chaque face d’'un maillage en autant de
surfaces indépendantes, on obtient une liste de
surfaces que I'on peut analyser et manipuler en méme
temps.

Ici, en trés peu de composant on peut les mettre

toutes a I'échelle d’'un méme facteur par rapport a leur
centre géométrique. Params > Geometry > Surface

Contient une surface.

Ce composant ne calcule rien, mais permet
Mesh > Analysis > de transporter des données de Rhino vers
Face Boundaries GH, ou encore d’un fichier GH a un autre

fichier GH, ou encore d’un endroit a l'autre

Permet d’extraire toutes d’'un méme fichier GH.

les faces d’'un maillage

en éléments séparés. Il est aussi capable de conversions simples.
Face Boundaries FC-Faces de base Scale

Geometry Geometry
Center
e Transform

/. .  Slider: FC-Facteur d'échelle
Properties Transform > Affine > Scale
L
Name FC-Facteur d'échelle FC-Facteur d'échelle Permet de projeter n’importe quelle

Expression géométrie sur un plan donné.

) = ~ 00500 g ' . :
Grip Style | Shape & Text N/ _I Ici, on projette les coins du maillage

lider accuracy sur le plan trouvé par GH par Fit Plane
Rounding \KI N E 0
Disits B Surface > Alaysis > Area
pimercibona Calcule I'aire d’'une géométrie donnée
Min +0[o[o[o[o]o[o[o[oJelo[1]} (marche aussi pour les maillages ou
Max MEREREERENERE | On régle avec ce curseur un les polysurfaces).
Range olo[ofo[o]a[o[o]o]jele]d] facteur d’échelle ! Ce composant est aussi souvent utilisé
T On cherche a réduire chaque face LR eille &« Euelie b G Ui

géométrie ; c’est a dire un point plus

I ofo[o[o[o[o[olo[ol5le[e] de maniere a créer des ou moins au centre.
[ I £ oo [EEEE A ouvertures dans les briques, ce
o curseur n’a donc pas besoin
Cancel d’aller au-dela de 1.
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Mise a I'échelle aléatoire

Le fait d’avoir une liste de surfaces différentes permet
aussi de décider de leur appliquer un facteur d’échelle
différent a chacune, tout en s’appuyant toujours sur le
centre géométrique de chacune d’elle.

Ici on utilise un générateur de nombres pseudo-
aléatoires pour obtenir une liste de nombres tous
différents

Sets > List > List Length

Compte le nombre d’éléments présents

dans une liste.

i .
aillage relaxé Face Boundaries FC-Faces de base , Scale
Dans le cas d’un arbre, ce composant

d b d Mesh V EhmREES ) — compte indépendamment les éléments de Geometry Rl
2 chaque branche Center
Y Area Transform
Geometry m’ Factor
i Random
e List Length

Sets > Sequence > Random

Permet d’obtenir un ou plusieurs nombres
qui sont choisis de maniere pseudo-
aléatoire au sein d’un certain domaine de
nombre possibles.

Construct Domain

FC-Facteur max

Maths > Domain > Construct Domain

Les domaines sont un types de données

spécifiques a Grasshopper. lls permettent
de contenir un nombre de début et un
nombre de fin en une seule donnée.

o Domain

UNE donnée, a traduire

Numeric domain between {A} and {B} «de 120,001 ».

- Les domaines peuvent
Cne locally defined wvalue.. atre croissants ou
1 To 0.001 décroissants.

Mathieu Monceaux / Félix Chameroy 5/11




— ) ;
B N SA' Il 'J\Z \\» / MORPHOLOGIE - Etude d’une coque simple m e

A\
. (=
Ecole nationale \f\/
supérieure d'architecture

Montpellier | La Réunion

‘

Cela permet de
visualiser dans quel
ordre Grasshopper

Mise a I'échelle variable organise la liste de
ces surfaces.

De maniére plus construite, on peut utiliser la maniére

que Grasshopper a de structurer les données et

utiliser 'indexe de chaque surface pour mettre a

I'échelle difféeremment chaque face.

Les indexes étant de nombre entiers, on obtiendrait

des facteurs d’échelles bien trop grands ! On doit donc

traduire cette liste de nombre en une autre plus

applicable a des facteurs d’échelle.

Maths > Range > Series

Permet de créer une suite d'une certaine
quantité de nombres.

On lui donne la quantité, et il ajoute a un Remapped number
nombre de départ le nombre de I'écart -
souhaité autant de fois que nécessaire. isoézgzgly FEEIRCE] ST
lage Foiexs Face Boundaries FC-Faces de base Ici, on lui donne le nombre d’éléments que Seais 0.038906
: I'on a dans la liste de faces. Par défaut, il ROy 0.020499
Area . s e o Geometry 0.001
par.t de 0 et aputel 1a chague fois : on SR b 517543
s A2 D obtient donc une liste des indexes de tous cactor Transt DR
Centroid les éléments de la liste. 0.166805
0.142877
18ms 0.372354
Series 0.332166
Remap Numbers &
0.529891

Bounds

Maths > Domain > Remap Numbers

Permet de transformer une certaine
truct ; liste de valeurs : a partir d’'un domaine
Maths > Domain > Bounds source et vers un domaine cible, ce
composant va conserver tous les
rapports de distance des nombres de
la liste les uns avec les autres.

FC-Facteur max
[FC-Facteur max | W/ Bonie
A ; Evalue tous les nombres d’une liste
@ Domain & données, et ressort un domaine
croissant du plus petit nombre de la
liste d’entrée a son plus grand.

Numeric Domain between the lowest and highest numbers in {N}

One locally defined value..
17.224925 To 81.399725
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Mise a I'échelle variable : par rapport a un attracteur

Dans le monde de la géométrie dite « paramétrique », Ici, on va utiliser la distance de chacune des surfaces
les attracteurs sont des points dont la distance par par rapport a ce point pour réduire ou agrandir les
rapport a d’autres objets change des parameétres. ouvertures que 'on va réaliser..

Dans Rhino, placez un

point que vous c-34.285,24.194

référencerez ensuite dans Location of point object

Grasshopper pour servir
d’attracteur

e0e® % ENSAM - S4 - MORPHO - TD4.3dm

Paralléle

. . ace Boundaries FC-Faces de base Vector > Point > Distance Scale
Evalue la distance entre deux points. dc
) . (| Geometry
. ( Mes| Boundaries = q Geometry
\V Ici, on obtiendra donc un nombre mmm(  Conter
différent pour chaque face, puisque Transformm
la distance du centre de chaque face / Factor
Area n iee o
au point « attracteur » est différente.
3 Area D
Geometry FH
Centroid Stance
/\ Remap Numbers
FC-, tion 24ms

Bounds

Numbersk 1 Domain P/(
FC-Facteur max Construct Domain
[FC-Facteur max | 00.800 Domain start g
) u Domain
[FC-Facteur min | 00.001 Domain end

Value Mapped

Source

Target Clipped

On garde les composants de
remapping car les valeurs des
distances vont aussi étre bien trop
grandes pour étre appliquées a
une mise a I'échelle
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Mise a I'échelle variable : moduler I'impact de I'attracteur

. 5 s L. /. [ON } Graph Editor
Pour modifier I'influence de I'attracteur, on utilise le
Graph Mapper : un composant qui permet d'utiliser la — Soisinliniageiniig: -

N X N 3 L X [1] +0]0]0|o|o| 1] o|o|0]q]
courbe d’une fonction mathématique pour altérer une i ~Toaoa ol AN
liste de données. v 1] +0]0[0[o[o] 1] o[0]0[0)

On l'utilise par exemple souvent pour appliquer des T
parameétres cycliques avec des courbes périodiques Name Bezler
de la fonction Sinus. oreen IsValid Trie

Ici on I'utilise pour renforcer 'effet de I'attracteur, via
son option courbe de Bézier.

]
FCAMaillage relaxé Face Boundaries FC-Faces de base Scale
'm T Params > Input > Graph Mapper (G y T ——
\ b Le Graph Mapper permet de Center
Ceomeiimed Aes transformer une liste données de Factor ~Iransform
Centioid maniére flexible et contrélée.
23ms Distance Graph Mapper
- Remap Numbers
FcWﬂra\cn‘on Point A o
-
| @ Boigte Bounds Quick Graph
\ Numbers & Domain
FC-Facteur max Construct Domain
[ FC-Facteur max | 00.800 Domain start g
N Domain D
[FC-Facteur min I 00.001 Boaiiend [] None
v [E Bezier
Conic
] Gaussian
A Linear
N/ . .
Par?bma Display > Graphs > Quick Graph
Perlin X i
Affiche sous forme de graphique le
E Power o A =
) contenu d’une liste de données.
Sinc
N sine
Sine Summation
Square Root

Mathieu Monceaux / Félix Chameroy 8/11




Ecole nationale
supérieure d’architecture
Montpellier | La Réunion

Mise en volume des ouvertures pour la différence booléenne

Pour effectuer une différence booléenne,Grasshopper, comme

Rhino, a besoin de volumes fermés. Les briques du TD3 sont

bien des volumes fermés, mais les ouvertures créées sur les

pages précédentes ne sont toujours que des surfaces sans
épaisseur.

Pour faire de ces surfaces des volumes fermés qui percent

entierement les briques, on va extruder les surfaces des

ouvertures vers I'extérieur et vers l'intérieur.

Pour cela on a besoin de :

- Déterminer la direction de I'extrusion a partir du vecteur
perpendiculaire (on dit aussi vecteur normal) a la face en son
centre

- Déplacer la face vers le bas le long de ce vecteur de la moitié
de I'épaisseur souhaitée

- Extruder le long du vecteur normal la surface déplacée d’'une
certaine épaisseur

Scale Fc-@gntes
J L 1
ry Geometry 1
Center 6) /
Transform D 5

Factor S

Surface > Analysis >
Evaluate Surface

Permet d’obtenir un
grand nombre de
propriétés locales d’'une
surface en un point
donné.

Ici on veut récupérer le
vecteur normal a la
surface en ce point

FC-Ep boite de c%e

EvAluate Surface

— ) |
— N SAlll —\Z{;/ % MORPHOLOGIE - Etude d’une coque simple
&

Surface

& Bake...
Wire Display >
Disconnect >

@ Principal
[®) Reverse
¥ Flatten
@ Graft
@) Simplify
v @ Reparameterize

Set one Surface
Set Multiple Surfaces
Manage Surface collection

Clear values
Internalise data
Extract parameter

(@ Help...

Amplitude

‘o0 @

Paralléle

Extrude

Params > Util > Data Dam

En frangais « barrage » : il permet de
bloquer le flux de données du fichier GH

explicitement de faire passer les données

" Mapper
Quick Graph tant que l'utilisateur ne décide pas
Si le bouton Play s’affiche, cela
[ signifie que les données en

aval ne seront pas a jour,
appuyez dessus pour actualiser
Data Dam

— el

Motion
Wire Display >
Disconnect >

& Principal
(@) Reverse
¥ Flatten
@) Graft
[T Simplify

(Al Uni

3 Expression... >

Set one Vector
Set Multiple Vectors

Manage Vector collection

Clear values
Internalise data
Extract parameter

@ Help...

-xI2

© Ccommit changes
© cancel changes

Expression Editor ‘

Bien cliquer sur I'entrée
Expression...

% ENSAM - S4 - MORPHO - TD4.3dm

Surface > Freeform >
Extrude

Permet d’extruder une
géométrie le long d’'un
certain axe pour lui donner
du volume.

Extruder une surface
donnera un volume fermé,
extruder une courbe
donnera un volume ouvert.
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Graph Mapper (

Différence booléenne

Ouvrir le fichier .GH du TD3 sur les briques

MORPHOLOGIE - Etude d’une coque simple

List Item

Is Planar

(&

Merge

e
rep Join

FC-Briques

ot~

=

Brej
\ i P

ject Scale Face Boundaries

Scale

—( Geometry

FC-Courbes pergantes

e

v (@ Preview
Enabled
& Bake...
Wire Display
Disconnect

[2) Reverse
¥ Flatten
@ Graft

@) Simplify

Set one Brep
Set Multiple Breps
Manage Brep collection

Clear values

Internalise data

Extract parameter

@ Help...

Geometry |

Q)

Center
Transform

Factor

FC-Ep boite de coupe

,[FC—Ep boite de coupe |

15.000

Evaluate Surface

Surface

Point

Point
Normal

U direction
V direction

Frame

D

13ms

Si le fichier du TD
précédent ne donne pas
les résultats escomptés,
vous trouverez les
éléments nécessaires au
TD dans le dossier DATA

Vector

Amplitude

Amplitude

t=A Vector

Geometry
(%)  Motion 9

o Geometry

Transform

Intersect > Shape > Solid Difference

Performe une différence booléenne entre
deux volumes fermés.

Ce composant est lent, attention aux
structures de données qu’on lui transfere !

Solid Difference

Extrude
Graft Tree '

ﬂ Base
m Extrusion id

Direction

123ms

Sets > Tree > Graft Tree

Ce composant sépare une liste
de données en autant de
branches différentes d’un arbre.

Cf. TD3

Breps A
% Result D
( Breps B

% ENSAM - S4 - MORPHO - TD4.3dm

Bien faire attention que les
données internalisées gardent
leur structure en arbre

La différence booléenne devra
sinon calculer 96 fois la
différence avec 96 briques
différentes

@ Brep (FC-Briques)

Contains a collection of Breps (Boundary REPresentations)

96 locally defined values..
{0;0} (N = 1)
{071} (N = 1)
{0;2} (N = 1)
{0;3) (N = 1)
{0;4) (N = 1)
{0;5) (N = 1)
{0;6} (N = 1)

0T E (N )

Quick Graph {0;8} (N =1)
{0;9) (N = 1)
4
{0;95) (N = 1)
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Fin du TD : Variations autour du TD

eoe % ENSAM - S4 - MORPHO - TD4.3dm

[ XX % ENSAM - S4 - MORPHO - TD4.3dm

MORPHOLOGIE - Etude d’une coque simple

[ ] L] % ENSAM - S4 - MORPHO - TD4.3dm
4R
L ] L ] % ENSAM - S4 - MORPHO - TD4.3dm

eoe % ENSAM - S4 - MORPHO - TD4.3dm

Envoyez plusieurs captures d'écran de votre travail
a l'adresse mail suivante, avec pour OBJET :

NOMPRENOM - S4 - MORPHO - TD4

omi.ensam@ikmail.com

Liste des captures :

- une vue du fichier GH final sur laquelle on peut
e B o Mo Toedn voir les différents éléments d’annotation

- des vues Rhino de la coque avec ses briques
percées

- des vues Rhino de briques percées avec des
variations d’ouvertures, a partir :

- d’autres positions de I'attracteur
- d’autres réglages du Graph Mapper

- du composant Random

- d’un autre maillage

\.
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